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Preface

This guide describes how to use the Oracle NetSuite Adapter in your SOA composite
applications and Oracle Service Bus business services.

Audience

This guide is intended for users who want to create, deploy, test, and monitor applications that
use the Oracle NetSuite Adapter.

Related Resources

Refer to the Oracle Fusion Middleware library on the Oracle Help Center for additional
information.

¢ For Oracle SOA Suite information, see Oracle SOA Suite.
¢ For Oracle Service Bus information, see Oracle Service Bus.
* For adapters information, see On-Premises and Cloud SOA Adapters.

* For versions of platforms and related software for which Oracle products are certified and
supported, review the Certification Matrix.

Conventions

The following text conventions are used in this document:

Convention Meaning

boldface Boldface type indicates graphical user interface elements associated with an
action, or terms defined in text or the glossary.

italic Italic type indicates book titles, emphasis, or placeholder variables for which
you supply particular values.

monospace Monospace type indicates commands within a paragraph, URLSs, code in
examples, text that appears on the screen, or text that you enter.

ORACLE
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Introduction to the Oracle NetSuite Adapter

This section introduces the Oracle NetSuite Adapter.

Topics

e Oracle NetSuite Adapter

* Installing the Cloud Adapters

*  Performing Postinstallation Configuration Tasks
e Specifying the Oracle NetSuite Adapter WSDL
e Obtaining the Authentication Credentials

e Unsupported Features

1.1 Oracle NetSuite Adapter

ORACLE

The Oracle NetSuite Adapter enables you to create an integration with a NetSuite application.

NetSuite is a SaaS-based application for business management. The NetSuite platform
includes ERP, CRM, PSA, and e-commerce capabilities. To integrate users, NetSuite provides
a platform called SuiteCloud that consists of cloud development tools and infrastructure. The
SuiteTalk component of the SuiteCloud framework enables integration of NetSuite with other
on-premises or cloud solutions.

While SuiteTalk provides the ability to access NetSuite data and business processes through
an XML-based API, it requires skills such as Microsoft .NET or Java to build integrations with it.
The Oracle NetSuite Adapter addresses these requirements by providing a no-coding
approach for building integrations with NetSuite. This enables users who are not professional
developers to build integrations with NetSuite.

The Oracle NetSuite Adapter provides the following features:
e Quickly and easily connect on-premises systems and applications with NetSuite.

* Rapidly integrate with both cloud applications and with existing on-premises business
systems.

* Automate the process for discovering NetSuite's web service WSDLs based on the user
account.

« Eliminate the need to work with complex polymorphic data objects by elevating NetSuite
records and custom objects (records and fields) to strongly-typed objects.

» Display records based on NetSuite’s categorization.

» Provide available contextual information about business objects and operations to the
developer at design time.

«  Provide secured invocation to NetSuite’s web services by adhering to the role-based
permission structure enforced in NetSuite in a transparent fashion.

* Provide a standard adapter life cycle, controlled runtime environment, and monitoring
capabilities.
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Chapter 1
Installing the Cloud Adapters

For more information, see Configuring Oracle NetSuite Adapter Properties.

1.2 Installing the Cloud Adapters

This section describes cloud adapter installation details.

See the README. txt file available with the patch for instructions on installing the cloud
adapters.

After you complete adapter installation, perform the tasks described in Performing
Postinstallation Configuration Tasks.

# Note:

For information about supported versions and platforms, see the release certification
matrix at Supported System Configurations.

1.3 Performing Postinstallation Configuration Tasks

You must perform postinstallation configuration tasks after installing the cloud adapters.

For information about postinstallation configuration tasks, see the Oracle Cloud Adapters
Postinstallation Configuration Guide.

1.4 Specifying the Oracle NetSuite Adapter WSDL

Obtain the WSDL and connection information to specify on the Connection page from
NetSuite.

1.5 Obtaining the Authentication Credentials

Obtain the user name and password that are required for creating the Credential Store
Framework (CSF) authentication key in Oracle JDeveloper from your SOA domain
administrator. These credentials are required for most cloud adapters.

1.6 Unsupported Features

The adapter does not support the following features:

e Adapter runtime retry configuration properties such as jca.retry.count,
jca.retry.backoff, jca.retry.interval, and jca.retry.maxInterval.

e Message recovery in the Error Hospital in Oracle Enterprise Manager Fusion Middleware
Control.

e The display of properties in the Properties tab for a reference (outbound) adapter in
Oracle Enterprise Manager Fusion Middleware Control (for example, service WSDL URL,
CSF key used, and others). These are the reference adapters that you select on the
Services and References page.

* Rejected message handling

ORACLE 1o
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Chapter 1
Unsupported Features

Metrics such as the number of invocations.

The following message encryption and decryption features available when you right-click a
cloud adapter in the Exposed Service swimlane or External References swimlane in
Oracle JDeveloper:

— Protect Sensitive Data > Encrypt Request Data for cloud adapters in the Exposed
Service swimlane.

— Protect Sensitive Data > Decrypt Sensitive Data for cloud adapters in the External
References swimlane.

The policy attachments feature available when you right-click a cloud adapter in the
Exposed Service swimlane or External References swimlane in Oracle JDeveloper.
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Understanding the Oracle NetSuite Adapter
Features

The Oracle NetSuite Adapter provides the following features.

Topics
« Designing an Integration with the Adapter Configuration Wizard

e Monitoring Your Application During Runtime

2.1 Designing an Integration with the Adapter Configuration

Wizard

ORACLE

You use the Adapter Configuration Wizard to include the Oracle NetSuite Adapter in a SOA
composite application or an Oracle Service Bus business service.

The Adapter Configuration Wizard consists of configuration pages that enable you to select the
artifacts required to communicate with the NetSuite application. You can configure the adapter
in the outbound (target) direction.

# Note:

If the Localize Files dialog is displayed during adapter configuration, click Cancel.
You cannot localize the WSDL file.

e The Basic Info page prompts you to enter a meaningful name and optional description.

e The Connection page prompts you to specify the security policy and CSF authentication
key to use. The authentication key is created by clicking the Add icon to specify the key
name, NetSuite company name, user hame, and password.

e The Operations page prompts you to select the operation and business object on which to
perform the operation.

e The Summary page displays your selections for the outbound direction.

The following artifacts are created for each adapter instance in the Applications window in
Oracle JDeveloper:

e WSDL file: Only the standard WSDL file type is supported.

e JCA file: Contains the internal implementation details used by the adapter during runtime.
It contains the different interaction and connection properties used by the adapter.

When application configuration is complete, you can deploy the application from Oracle
JDeveloper to the runtime environment.

For information about the details to specify in the fields of the wizard pages, see Configuring
Oracle NetSuite Adapter Properties.
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Chapter 2
Monitoring Your Application During Runtime

2.2 Monitoring Your Application During Runtime

ORACLE

This section describes the design time and runtime aspects of using the adapter.

You use the runtime part of the adapter for delivering the information generated during design
time to the service endpoint. You can monitor your SOA composite application or Oracle
Service Bus business service from Oracle Enterprise Manager Fusion Middleware Control. You
can also test your Oracle Service Bus business service from Oracle Service Bus Console.
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Designing SOA Composite Applications

This section describes how to design a SOA composite application with the Oracle NetSuite
Adapter.

Topics

Creating a SOA Composite Application
Adding an Adapter to a SOA Composite Application as a Reference
Completing Design of a SOA Composite Application

3.1 Creating a SOA Composite Application

This section provides an overview of how to create a SOA composite application in which to
include the adapter as an exposed service or external reference.

1.
2.
3.

Start Oracle JDeveloper.
From the File menu, select New > Application.

In the New Gallery dialog, select SOA Application from the Items list, then click OK. The
SOA Create SOA Application wizard is displayed.

Specify an application name, and click Next.
Specify a project name, and click Next.
Select Composite with BPEL Process, and click Finish.

The SOA composite application is displayed for designing in the SOA Composite Editor.

3.2 Adding an Adapter to a SOA Composite Application as a
Reference

You can add an Oracle NetSuite Adapter to a SOA composite application as an outbound
(target) reference to the External References swimlane in Oracle JDeveloper.

ORACLE

1.
2.

Go to the Component Palette in your SOA composite application.
Go to the Cloud section under Custom/Third Party.
The adapters are displayed.

To create an outbound (target) reference, drag the adapter to the External References
swimlane, and see the following sections that describe the wizard pages for configuring the
adapter.

*  Configuring Basic Information Properties
»  Configuring Oracle Cloud Adapter Connection and CSF Key Properties
»  Configuring Oracle NetSuite Adapter Invoke Operation Properties

* Reviewing Configuration Values on the Summary Page
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Chapter 3
Completing Design of a SOA Composite Application

3.3 Completing Design of a SOA Composite Application

ORACLE

This section provides an overview of how to complete design of your SOA composite
application and deploy the application.

1. Design the remaining contents of your SOA composite application. For example:

a. Connect the BPEL process to the adapter. For this example, the BPEL process is
connected to the adapter as an external reference:

b. Design the contents of the BPEL process. For example:
i. Double-click the BPEL process.
ii. Add and configure an invoke activity to invoke the adapter.

iii. Add and configure assign activities to copy the contents of one variable to another
when sending and receiving messages to and from the adapter.

iv. Add and configure other activities, as appropriate.

When complete, view the SOA composite application in the SOA Composite
Editor.

For specific information about creating and designing SOA composite applications, see
Developing SOA Applications with Oracle SOA Suite.

2. Deploy the SOA composite application:
a. Inthe navigator, right-click the project and select Deploy > project_name.

b. Follow the steps in the deployment wizard to deploy the SOA composite application to
the application server.
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Designing Oracle Service Bus Business
Services

This section describes how to design an Oracle Service Bus business service with the adapter
in Oracle JDeveloper.

Topics
e Creating an Oracle Service Bus Business Service

* Adding an Adapter to a Business Service as a Reference

e Completing Design of an Oracle Service Bus Business Service

4.1 Creating an Oracle Service Bus Business Service

This section provides an overview of how to create an Oracle Service Bus business service in
which to include the adapter in Oracle JDeveloper.

1. Start Oracle JDeveloper.
2. From the File menu, select New > Application.

3. Inthe New Gallery dialog, select Service Bus Application from the Items list, then click
OK.

4. Specify an application name, and click Next.
5. Specify a project name.
6. Select Service Bus, and click Finish.

The Oracle Service Bus business service is displayed for designing in the Oracle Service
Bus Overview Editor.

4.2 Adding an Adapter to a Business Service as a Reference

ORACLE

You can add the adapter to an Oracle Service Bus business service as an outbound (target)
external service to the External Services swimlane in Oracle JDeveloper.

# Note:
If the Import OSB Resource dialog is displayed during adapter configuration, click

Cancel. You cannot localize the WSDL file.

1. Go to the Component Palette in your Oracle Service Bus business service.
2. Go to the Cloud section under Service Bus.

The adapters are displayed.
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Chapter 4
Completing Design of an Oracle Service Bus Business Service

To create an outbound (target) external service, drag the adapter to the External Services
swimlane, and see the following sections that describe the wizard pages for configuring the
adapter:

*  Configuring Basic Information Properties
e Configuring Oracle Cloud Adapter Connection and CSF Key Properties
»  Configuring Oracle NetSuite Adapter Invoke Operation Properties

* Reviewing Configuration Values on the Summary Page

4.3 Completing Design of an Oracle Service Bus Business

Service

ORACLE

This section provides an overview of how to complete design of your Oracle Service Bus
business service and deploy the application.

1.

Design the contents of your Oracle Service Bus business service. For example, to
configure an Oracle Service Bus proxy service in your business service:

a. Inthe Oracle Service Bus Overview Editor, right-click the Pipeline/Split Joins lane
and select Insert > Pipeline.

The Create Pipeline Service dialog is displayed.
b. Enter a name for the pipeline and select the project location, then click Next
c. Select WSDL as the Service Type.
d. To the right of the WSDL selection, click the Browse icon to select the WSDL.
e. Select Application.
f. Expand Resource Chooser and select the WSDL file, then click OK.
g. Ensure that Expose as a Proxy Service is selected.
h. From the Proxy Transport list, select http, then click Finish.
The Pipeline component is displayed in the Oracle Service Bus Overview Editor.
i. Connect the external service to the Pipeline component.

For more information about creating and designing an Oracle Service Bus business
service, see Developing Services with Oracle Service Bus.

Open the pipeline that shows the default routing.

Verify the service and corresponding operation are displayed in the Routing Properties
tab at the bottom of the dialog.

The outbound project is ready for deployment.

Deploy the business service.

# Note:
You cannot use Oracle JDeveloper to deploy a business service to Oracle SOA

Cloud Service.

a. Select the project, then select Deploy to Service Bus Server.
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Completing Design of an Oracle Service Bus Business Service

b. Follow the steps in the deployment wizard.
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Configuring Oracle NetSuite Adapter
Properties

The Oracle NetSuite Adapter enables you to create integrations with a NetSuite cloud
application.

The following sections describe the wizard pages that guide you through configuration of the
Oracle NetSuite Adapter as an invoke in an integration. The Oracle NetSuite Adapter cannot
be configured as a trigger in an integration.

Topics

e Configuring Basic Information Properties

e Configuring Oracle Cloud Adapter Connection and CSF Key Properties

e Configuring Oracle NetSuite Adapter Invoke Operation Properties

e Reviewing Configuration Values on the Summary Page

For more information about the Oracle NetSuite Adapter, see Oracle NetSuite Adapter.

5.1 Configuring Basic Information Properties

You can enter a name and description on the Basic Info page of each source and target
adapter in your integration.

Topics
* What You Can Do from the Basic Info Page

* What You See on the Basic Info Page

5.1.1 What You Can Do from the Basic Info Page

ORACLE

You can specify the following values on the Basic Info page. The Basic Info page is the initial
wizard page that is displayed whenever you drag an adapter to the trigger (source) or invoke
(target) area supported by your adapter.

e Specify a meaningful name.

»  Specify a description of the responsibilities.
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Chapter 5
Configuring Oracle Cloud Adapter Connection and CSF Key Properties

5.1.2 What You See on the Basic Info Page

The following table describes the key information on the Basic Info page.

Element Description

What do you want to call your endpoint? Provide a meaningful name so that others can

understand the responsibilities of this connection.

You can include English alphabetic characters,

numbers, underscores, and dashes in the name.

You cannot include the following:

*  Blank spaces (for example, My Inbound
Connection)

»  Special characters (for example, #;83& or
righ (t)now4)

e Multibyte characters

What does this endpoint do? Enter an optional description of the connection’s
responsibilities. For example: This connection
receives an inbound request to
synchronize account information with
the cloud application.

5.2 Configuring Oracle Cloud Adapter Connection and CSF Key
Properties

Enter the Oracle Cloud adapter configuration connectivity and Credential Store Framework
(CSF) key values for your integration.

Topics

* What You Can Do from the Oracle Cloud Adapter Connection Page

* What You See on the Oracle Cloud Adapter Connection Page

*  What You Can Do from the Oracle Cloud Adapter CSF Key Page

* What You See on the Oracle Cloud Adapter CSF Key Page

5.2.1 What You Can Do from the Oracle Cloud Adapter Connection Page

You can specify the following connection values for the Oracle Cloud adapter.

«  Specify the WSDL URL for some adapters. If you are configuring the Oracle Eloqua Cloud
adapter, no WSDL is required.

*  Specify the security policy.

* Create the authentication key. A key created for one direction (for example, outbound) is
also available for selection in the other direction (for example, inbound).
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Chapter 5

Configuring Oracle Cloud Adapter Connection and CSF Key Properties

5.2.2 What You See on the Oracle Cloud Adapter Connection Page

The following table describes the key information on the Oracle Cloud adapter Connection

page.
Element Description
WSDL URL Note: This field is not displayed for the Oracle

Eloqua Cloud adapter.

Specify the WSDL. The WSDL is used to build
integrations specific to your instance. You can also
select the WSDL from a file system or another
source by choosing the browser icon next to the
WSDL URL field. Click File System at the top of
the dialog, then browse for the WSDL.

Security Policy

Select the security policy appropriate to your
environment (for example,
USERNAME_PASSWORD_TOKEN).

e The wizard shows all policies, including those
that may not be applicable. To make a correct
selection, you must have a knowledge of
policies. For example, you cannot select a
SAML-based policy because the identity is not
propagated.

e The policies you apply to the cloud adapter are
unique to the cloud adapter and do not impact
other endpoints in the composite.

Authentication Key

Select the CSF authentication key.

* Add: Click to create a new authentication key.
You must specify the key name, user name,
and password.

»  Edit: Click to edit an authentication key.
* Delete: Click to delete an authentication key.

Test

Click to validate the authentication key.

5.2.3 What You Can Do from the Oracle Cloud Adapter CSF Key Page

You can specify the following CSF key values for the Oracle Cloud adapter.

e CSF key name

e User name and password

e If you are configuring the Oracle Eloqua Cloud adapter only, you must specify a company

name.

ORACLE
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Chapter 5

Configuring Oracle NetSuite Adapter Invoke Operation Properties

5.2.4 What You See on the Oracle Cloud Adapter CSF Key Page

The following table describes the key information on the Oracle Cloud adapter CSF Key page.

Element

Description

CSF Key Name

Specify the CSF key to enable runtime injection of
credentials. The adapter uses the CSF to retrieve
the username and password required for
authentication with the application (for example, the
Oracle Sales Cloud or Oracle ERP application).
This key identifies your login credentials during
design-time.

Company Name (Oracle Eloqua Cloud adapter
only)

Note: This field is only displayed for the Oracle
Eloqua Cloud adapter.

Specify the Oracle Eloqua company name.

Email Account and Role

Note: This field is only displayed for the Oracle
NetSuite Cloud adapter.

Specify the email account and role.

User Name Enter the user name for connecting to your
application (for example, the Oracle Sales Cloud or
Oracle ERP application). Your administrator
provides you with user credentials.

Password Enter the password for connecting to your

application.

Re-enter Password

Re-enter the same password a second time.

Application ID (NetSuite Adapter only)

Enter the application ID. When creating a SOA
composite application, this field is optional if you
are using a NetSuite 2015 WSDL and mandatory if
using a NetSuite 2016 WSDL.

5.3 Configuring Oracle NetSuite Adapter Invoke Operation
Properties

Enter the Oracle NetSuite Adapter invoke operation values for your integration.

Topics

¢ What You Can Do from the Oracle NetSuite Adapter Invoke Operations Page

¢ What You See on the Oracle NetSuite Adapter Invoke Operations Page

5.3.1 What You Can Do from the Oracle NetSuite Adapter Invoke
Operations Page

You can configure the following invoke operation values for the Oracle NetSuite Adapter.

e Select the operation to perform.

*  Select the business object on which to perform the operation.
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Chapter 5
Configuring Oracle NetSuite Adapter Invoke Operation Properties

5.3.2 What You See on the Oracle NetSuite Adapter Invoke Operations

Page

The following table describes the key information on the invoke Operations page.

Element

Description

Select an Operation Type

Select the type of operation to perform on the business object:

Basic

Add: Adds a record into the system.

— Delete: Deletes a record from the system.

Get: Queries the system for a record.

Update: Updates an existing record in the system.

Miscellaneous

Select a specific operation. If you select Miscellaneous, you do

not need to select a business object (the Select Business

Objects table is not visible).

— GetBudgetExchangeRate: Gets and filters data related to
the budget exchange rate.

— GetConsolidatedExchangeRate: Gets and filters all data
related to the consolidated exchange rate.

— GetCurrencyRate: Gets and filters the current currency
rate.

—  GetltemAuvailability: Retrieves the inventory availability for a
given list of items.

— GetPostingTransactionSummary: Retrieves a summary of
the actual data in an account.

Filter by object name

Type the initial letters to filter the display of business objects.

Select Business Objects

Select the business object to use.

Your Selected Business
Objects

Displays the selected business objects.

Processing Options

Select this link to enable and disable certain aspects of NetSuite
cloud application server-side processing when performing an
operation.

Treat Warning As Error:

If selected, the endpoint treats all warning messages that are
displayed by the NetSuite cloud application as errors.

Ignore Read Only Fields:

If selected, the endpoint ignores read-only fields during any
requests.

Insert record on Update if not Exist:

If selected, a record is inserted if one does not exist. This option
is only displayed if the Update operation type is selected.
Search Page Size: Select the number of search results to return

on a single page. The minimum value is 5 and the maximum
value is 1000.

ORACLE
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Chapter 5
Reviewing Configuration Values on the Summary Page

5.4 Reviewing Configuration Values on the Summary Page

You can review the specified adapter configuration values on the Summary page.

Topics
e What You Can Do from the Summary Page

e What You See on the Summary Page

5.4.1 What You Can Do from the Summary Page

You can review source or target configuration details from the Summary page. The Summary
page is the final wizard page for each adapter after you have completed your configuration.

*  View the configuration details you defined for the source or target adapter. For example, if
you have defined an inbound source adapter with a request business object and
immediate response business object, specific details about this configuration are displayed
on the Summary page.

e Click Done if you want to save your configuration details.

»  Click a specific tab in the left panel or click Back to access a specific page to update your
configuration definitions.

e Click Cancel to cancel your configuration details.

5.4.2 What You See on the Summary Page

The following table describes the key information on the Summary page.

Element Description

Summary Displays a summary of the source or target
configuration values you defined on previous pages
of the wizard.

For adapters for which a generated XSD file is
provided, click the XSD link to view a read-only
version of the file.

To return to a previous page to update any values,

click the appropriate tab in the left panel or click
Back.
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Managing Applications

This section describes how to manage and monitor an Oracle SOA Suite or Oracle Service
Bus application that uses the adapter from Oracle Enterprise Manager Fusion Middleware
Control or Oracle Service Bus Console.

Topics

Managing the Application in Oracle Enterprise Manager Fusion Middleware Control

Testing Oracle Service Bus Projects from Oracle Service Bus Console

6.1 Managing the Application in Oracle Enterprise Manager
Fusion Middleware Control

You manage the SOA composite application or Oracle Service Bus business service that
includes your adapter in Oracle Enterprise Manager Fusion Middleware Control.

1.
2.

Log in to Oracle Enterprise Manager Fusion Middleware Control.

In the navigator, expand the tree to display your SOA composite application or Oracle
Service Bus business service project (for this example, a SOA composite application is
selected).

Select the SOA composite application.

Click Test.

The Test Web Service page is displayed.

Complete the fields on the page to initiate a test of your composite.
Click Test Web Service.

Invocation results are displayed.

Click Launch Flow Trace to view the flow trace of the SOA composite application,
including flow details about the adapter.

For more information about monitoring applications from Oracle Enterprise Manager
Fusion Middleware Control, see Administering Oracle SOA Suite and Oracle Business
Process Management Suite and Administering Oracle Service Bus.

6.2 Testing Oracle Service Bus Business Services from Oracle
Service Bus Console

You can test Oracle Service Bus business service projects from Oracle Service Bus Console.

ORACLE

1.
2.
3.

Log in to Oracle Service Bus Console.
In the navigator under All Projects, open the project to test.

In the navigator, click the business service for that project.
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Chapter 6
Testing Oracle Service Bus Business Services from Oracle Service Bus Console

Click the Launch Test Console (green arrow button) to test the outbound endpoint.
This opens a window that displays the proxy service and the operation to test.

Provide the input and click Execute.

This sends the payload to the Oracle Cloud application. The response is displayed under
the Response Document section.

For more information about testing Oracle Service Bus business service projects, see
Administering Oracle Service Bus.

6-2



	Contents
	Preface
	Audience
	Related Resources
	Conventions

	1 Introduction to the Oracle NetSuite Adapter
	1.1 Oracle NetSuite Adapter
	1.2 Installing the Cloud Adapters
	1.3 Performing Postinstallation Configuration Tasks
	1.4 Specifying the Oracle NetSuite Adapter WSDL
	1.5 Obtaining the Authentication Credentials
	1.6 Unsupported Features

	2 Understanding the Oracle NetSuite Adapter Features
	2.1 Designing an Integration with the Adapter Configuration Wizard
	2.2 Monitoring Your Application During Runtime

	3 Designing SOA Composite Applications
	3.1 Creating a SOA Composite Application
	3.2 Adding an Adapter to a SOA Composite Application as a Reference
	3.3 Completing Design of a SOA Composite Application

	4 Designing Oracle Service Bus Business Services
	4.1 Creating an Oracle Service Bus Business Service
	4.2 Adding an Adapter to a Business Service as a Reference
	4.3 Completing Design of an Oracle Service Bus Business Service

	5 Configuring Oracle NetSuite Adapter Properties
	5.1 Configuring Basic Information Properties
	5.1.1 What You Can Do from the Basic Info Page
	5.1.2 What You See on the Basic Info Page

	5.2 Configuring Oracle Cloud Adapter Connection and CSF Key Properties
	5.2.1 What You Can Do from the Oracle Cloud Adapter Connection Page
	5.2.2 What You See on the Oracle Cloud Adapter Connection Page
	5.2.3 What You Can Do from the Oracle Cloud Adapter CSF Key Page
	5.2.4 What You See on the Oracle Cloud Adapter CSF Key Page

	5.3 Configuring Oracle NetSuite Adapter Invoke Operation Properties
	5.3.1 What You Can Do from the Oracle NetSuite Adapter Invoke Operations Page
	5.3.2 What You See on the Oracle NetSuite Adapter Invoke Operations Page

	5.4 Reviewing Configuration Values on the Summary Page
	5.4.1 What You Can Do from the Summary Page
	5.4.2 What You See on the Summary Page


	6 Managing Applications
	6.1 Managing the Application in Oracle Enterprise Manager Fusion Middleware Control
	6.2 Testing Oracle Service Bus Business Services from Oracle Service Bus Console


